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Sprint-Layout 6.0
 

· Sprint-Layout is an easy-to-use software to create layouts for single-sided, double-sided or even
multilayer PCB's (Printed Circuit Boards). The software comes along with all functions that are
necessary for board design. Even professional features, like export of Gerber-files or isolation-milling are
included, while the handling of Sprint-Layout was kept self-explaining.

· There are no restrictions or paternalisms how to draw your layout. You can place pads, draw tracks,
change layers, etc. as you wish. You have full control of your layout design.

· There is a special mode for every working step like placing pads, drawing tracks or zones, adding text
labels, etc. Just select the corresponding mode and there you go.

· Important drawing parameters like track width, pad size or the current grid setting are visible at a glance
and can be changed at any time. The integrated grid capture can be switched off at any time simply
with the CTRL key, so you can work freehand on tricky places.

· You can change and edit existing layout elements at any time. Just select e.g. a track and change their
width. All changes are immediately visible on the screen and so you can always assess your changes.

· Functions like copy, move, cut or paste exist as well as functions to rotate, mirror or align.

· Sprint-Layout manages a copper- and a silkscreen-layer for each board side (top and bottom).
Additional there is an extra layer for the board-outline (shape) and for cut-outs within the board. If
needed, there are two additional copper layers for the inner layers of a multilayer board. You can show
or hide each layer at any time. You may also change the colors of the layers.
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· The included macro library already contains many standard components, which can be placed on your
board by drag&drop. If there is a component missing, it is no problem to draw this component, and save
it to the macro library. 

· You may use the integrated auto-router to connect individual tracks. But Sprint-Layout is not made for
routing complete boards automatically.

· The photo-view function lets you take a look on your board as if it was already produced. This feature
helps you to find typical errors like wrong mirrored texts or components.

· Extensive and comfortable printing options allows you to print your layouts or component-mounting-
plans on paper or foil.

· You may export your layout to a BMP, GIF or JPG format. These pictures can be used in other
programs like Word or for publishing on your homepage.

· Sprint-Layout can create Gerber- and Excellon files for a professional manufacturing of your board.

· Isolation-milling is also supported. Sprint-Layout is able to generate to necessary data and export a
HPGL file (plt). These files can be used with the milling-software for your CNC milling-machine.

· The possibility of a Gerber import allows you to load existing Gerber files and convert them to a ready
layout in Sprint-Layout.

Created with the Standard Edition of HelpNDoc: Full featured Documentation generator

New features of Sprint-Layout 6.0
 
Anti-alias
The graphic representation of Sprint-Layout is substantially improved by the use of the anti-alias technology.

Bigger resolution and accuracy
The resolution and the accuracy of Sprint-Layout is increased tenfold. This concerns also the grid settings
and the maximum zoom factor. So there is no problem to design very fine layout structures.

Components
Sprint-Layout is now able to display and manage components including identifier and value. Even a
component-list is available.

Pick+Place data
Sprint-Layout is now able to generate and export pick+place files. These files are necessary for automated
assemblies of SMD boards.

Gerber import
The possibility of a Gerber import allows you to load existing Gerber files and convert them to a ready layout
in Sprint-Layout.

Multiselect - Simultaneous editing of several elements
With the properties-panel you can now edit as many elements as you want simultaneously.

Selector
The new selector is a powerful tool. With this tool you can find and select specific elements of your layout,
and edit them simultaneously with the help of the new multiselect-function. For example, you can select and
edit all pads with a specific shape or drilling.

Automatic capture mode
This new capture mode makes it easier to place pads or tracks. Whenever the mouse gets close to a

http://www.helpndoc.com
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capture-point, the mouse will be captured to this point, and helps you to connect exactly. This is particularly
very helpful, if some connections are lying out of the grid.

Rubber-band
While moving elements, the connected tracks can keep their connection, just like rubber-bands.

Rectangle
With the new rectangle drawing mode you can draw rectangles (tracks or zones) in an easy way.
 
Grid-Hotkeys
The keys 1..9 on your keyboard are now assigned to (editable) grid values. So you can change between
several grid values with just one keystroke.

New Crosshair
The new crosshair is now consistently involved in every action. It can display additional 45° lines and the
numeric values of the coordinates directly on the crosshair.

Circular arrangement
The exact circular arrangement is a tricky and invidious job. Sprint-Layout has now a special assistant for
that. You will only have to define the necessary parameters, and you can see the results of your parameters
in a preview before you complete the action.

Thermal-pad vias
If you use vias as a thermal-pad, you can now define the thermal-pads separated for each layer.

Isolation milling
The isolation milling was completely revised. All individual jobs like isolation milling, drilling or cut-out will
now be written in one plotfile. So typical problems with the origin in various files will be prevent.

...and much more little improvements

 

Created with the Standard Edition of HelpNDoc: Easily create CHM Help documents

Software registration 

This registration is not necessary for working with the software.
You can send us your registration form, to get information about updates and new ABACOM products. 

If you received your software directly from ABACOM, registration is not necessary.

To call the registration form call Register software... from the ? menu.
 

Created with the Standard Edition of HelpNDoc: Easily create HTML Help documents

Board properties
 
Starting with a new project, the first step is to define the dimensions of the board.
Select from the main-menu the command File | New...

http://www.helpndoc.com/feature-tour
http://www.helpndoc.com/feature-tour
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If you want to start with a board without any special board-outline, or if you want to draw your board-outline
by yourself, then select the first option Empty workspace without PCB outline.
The 2 other options lets you select between a rectangle or a round board. The board-outline will be
generated automatically according to your parameters on the outline-layer (O).
The resulting working-space can not be larger than 500x500 mm.

You may change these parameters at any time you want.
Select from the main-menu the command  Board | Properties... or call the command from the local popup-
menu of the tab (below the working-space).

  
The properties-panel will appear on the right site.
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You may now edit the size of the working-space or the name for the board. 
The option Multilayer offers 2 additional inner layers I1 and I2 to create multilayer PCB's. 

Created with the Standard Edition of HelpNDoc: Easily create Web Help sites

Adjust the grid capture
 

One of the most important functions of Sprint-Layout is the grid capture. This grid allows the quick and
exact placement of all elements. The grid capture is always active, and the grid is displayed on the screen.
If the current zoom is too small to display the grid on the screen in a reasonable way, the grid will be not
shown on the screen, but even then the grid capture is still active.

You may change the size of the grid whenever you want. The change of the grid-size will not have any effect
to the designed layout. If you can not reach the wanted position on the board, you may decrease the grid-
size.

Tip:
You can deactivate the grid capture temporary at any time.
Just press and hold the CTRL-key while moving or drawing elements.

You can set the grid-size to any value you like. But in the most cases it is rational to set the grid-size to
divider of the default grid-size of 2,54 mm (1/10 Inch). 
 
To adjust the grid-size click on the corresponding button in the left sidebar:

 
 
The menu to set the grid-size will appear.
 

 
The top red entries  are the default values in inch format. 
Click on Metric grids to select a new grid-size in metric format.
You may also define your own grid-sizes. Click on User grids and define a new grid-size, or select a
previous defined grid-size from the list.

 
Hotkeys...
The keys 1..9 on your keyboard are hotkeys for special grid-sizes. You can change the grid-size with just

http://www.helpndoc.com/feature-tour
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one click on one of these keys.
Here you can define the grid-sizes for these keys:

Subdivisions
Per default, every 5th grid-line is displayed more thick than the others. This is often helpful for the
orientation.In this sub-menu you may adjust or deactivate this feature.
 
Show grid
With this option you can show or hide the grid.
Note: Even if you hide the grid, the grid-capture is still active.

Created with the Standard Edition of HelpNDoc: Free iPhone documentation generator

The meaning of the layers
 
Sprint-Layout supports up to 7 different layers. You may imagine a layer as a transparent foil. You can put
several layers one above the other and look at all layers at the time time.

Every layer has its own meaning:

· C1 = Copper - Top

· S1 = Silkscreen - Top

· C2 = Copper - Bottom

· S2 = Silkscreen Bottom

· O = Outline-layer for the outline of the PCB and for possibly cut-outs

· I1 = Copper - Inner layer 1 (only in multilayer boards)

· I2 = Copper - Inner layer 2 (only in multilayer boards)

http://www.helpndoc.com/feature-tour/iphone-website-generation
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There are 2 layers for the top and the bottom side of the board. One copper-layer for the copper-layout and
one additional silkscreen-layer for an optional silkscreen on the board.
You may use the outline-layer O to draw your board outline. This may be a simple rectangle or also a
complex shape with several cut-outs. Just draw the outlines with thin tracks or circle.segments on the O-
layer. The O-layer can be used for a professional manufacturing of the board.

 
Please note the following points if you start to design a board:

· Side 1 is the TOP of your board

· Side 2 is the BOTTOM of your board

· Always design your board from the TOP side, and look through all layers as if the board were
transparent

· Note, that every text or component on the BOTTOM has to be mirrored (Sprint-Layout will do this for you
automatically).

All new drawing elements will be placed on the current active layer.
In the lower status-bar of Sprint-Layout you can always see or change the active layer:

The radio buttons select the active layer.

You may also hide a single layer. The buttons C1, S2, C2, S2 or O above the radio buttons toggle the
visibility of the layer. Please note, that the active layer is always visible.
 
With a click on the ? you can call the LayerInfo:
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This summary explains the meaning of the layers and their colors.

Created with the Standard Edition of HelpNDoc: Free Web Help generator

Rulers and coordinates
 
Sprint-Layout offers two important features for a better orientation on the board:

 
Rulers
The rulers are on the top and on the left border of your board. The current mouse position is marked for a
better orientation.
You can change the unit of these rulers from millimeter to mil (1 mil = 1/1000 inch). Just click on the little
button in the top/left edge of the rulers to toggle the unit. The current unit is always displayed on this button.

Coordinates
The coordinates are displayed on the left in the below statusbar:
 

 
The units of these coordinates correspond to the ruler units.

Move the origin
Normally the origin is on the bottom/left edge of your working-space.

http://www.helpndoc.com
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Sometimes it is necessary to move this origin. If you have drawn a board outline, it may be important to set
the origin to the bottom/left edge of this outline:

The origin is displayed as a little cross. You can simply click on it and drag it to the new position.
 
 
Tip:
When moving the origin it will be captured to the current grid.
You may press and hold the STRG-Key to reach positions that are out of the grid.

 

Created with the Standard Edition of HelpNDoc: Full featured Documentation generator

Working with several boards
 
A Sprint-Layout file can contains several boards. It may be useful to save a project with several boards into
one single file. In this case, you have access to all boards of the project within just one file.
Every board has its own tab below the working-space:

 
Just click on a tab to select the board.
You can also change the order of these boards, or add new boards from other Sprint-Layout files.

With a right-click on a tab, you can call a local popup-menu with the following functions:
(You can also call these functions from the main-menu Board)

Add new board...
This function adds a new empty board to your project.
 
Board properties...
This function shows the properties-panel for the board on the right side. Here you can edit the board-size,
the board-name, etc.

Copy board
This function copies the current selected and adds this copy to your project.
 
Delete board...
This function deletes the board from your project.
 
Sort boards

http://www.helpndoc.com
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There are 4 functions available to change the order of your boards:
 

· Set board to right

· Set board to left

· Move board to right

· Move board to left

 
Import boards from file...
You can import the boards from other Sprint-Layout files. These boards will be added as new boards in your
project.
To import the boards from another Sprint-Layout file select Board | Import boards from file... from the
main-menu.
If you don't want to add all boards from the other file, just delete the unneeded boards after you have
imported them.

Created with the Standard Edition of HelpNDoc: Easy CHM and documentation editor

Basic drawing functions
 
Sprint-Layout contains all necessary drawing functions to design a board:
 

· Tracks / Lines

· Pads, Through-Pads (Vias), Drillings

· SMD-Pads

· Circles / Segments

· Rectangles

· Zones

· Special forms (polygons, spirals, etc.)

· Texts
 
There is a drawing mode for each of this drawing function. You can select the drawing mode in the left
sidebar.
 
Please always return to the edit-mode if you want to select, edit or move elements.
To return quickly to the edit-mode, you can click with the right mouse button on the working-space or to
press the ESC-key.

 
Tip:
You can call a local popup-menu with a right-click on the working-space. This menu gives you a quick and
comfortable access to many often used functions.

 

Select
After you have drawn some elements, you can edit them at any time. You can move, delete, copy or edit
these elements. If you want to edit an element, you will have to select it first. Please return to the edit-mode
if you are still in any other drawing mode. Now, just click on the element you wish to edit. The element will
change his color to magenta. This color always identifies selected elements. To deselect all selected
elements, just click on an empty space. All selected elements will be deselected immediately.

If you want to select more elements at once, you can draw a frame around all elements. Just click on an
empty space, draw your frame and release the mouse button. All elements which lie inside (or partially
inside) this frame will be selected.

If you want to select several single elements, you can also use the SHIFT-key. Press and hold the SHIFT-
key and now you can select one element after another without deselecting the former selected elements.

http://www.helpndoc.com
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Tip:
If you want to select a single element out of a group or a macro, just press and hold the <ALT>-key and
then click on the desired element.

 
You can also combine all these functions, to create even complex selections.

Move
Select the elements that you want to move. Then click to one of the selected elements and hold the left
mouse button down. Move the elements to the desired position and release the mouse button to drop them. 
You may also use the ARROW keys of your keyboard to move selected elements.

Tip:
Hold down the <CTRL> key of your keyboard, to turn off the grid-capture, if you have to reach positions that
are off the grid. 

 

Delete 
Select the elements you want to delete. The function DELETE is available from the EDIT item of the main
menu or from the toolbar. You may also press the <DEL> key of your keyboard or the corresponding button
in the toolbar to remove selected elements from the layout.

Created with the Standard Edition of HelpNDoc: Create iPhone web-based documentation

Tracks

To draw a copper track select the corresponding mode from the left sidebar:
 

 
If you move the mouse to the layout, you will see an additional point in the size of the current track width.
This point defines the starting point of your new track. Click with the mouse to confirm the starting point.
From now on, there is always an angled track-segment sticking on your mouse-cursor. With additional
clicks you can now draw your track.

If you want to finish drawing, just click with the RIGHT mouse-button. You can now start to draw a new
track. If you want to exit the track-mode just click again with the RIGHT mouse-button, or press <ESC>.

http://www.helpndoc.com/feature-tour/iphone-website-generation
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Bend mode
While drawing a track, you can change the bend mode of the track by pressing the <SPACE> key. There
are 5 bend-modes altogether and you can simply toggle through these modes with the <SPACE> key.

 

Tip:
Hold down the <CTRL> key of your keyboard, to turn off the grid-capture, if you have to reach positions that
are off the grid. 

The current track-width is shown in the left sidebar below the mode-buttons:
 

 
Here you can change the current track-width at any time. 
A width of "0" is always drawn as the thinnest line that is supported by the device (screen or printer).

Favorite list
For often used track widths there is a favorite list available. Click with the mouse on the symbol left to the
edit field:

A menu will appear and you have access to your favorite track-widths with just one click:

 
If the current value is not in the list, you may add it to the list with the "+" option.
If the current value is already in the list, the entry is marked.
You can remove unneeded entries with the Remove option.
 
 
Modify existing tracks
To modify an existing track, select the track:
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The nodes of the track will be drawn as solid blue points. You may click on a node and drag it to a new
position.

Virtual nodes 
These nodes are located in the middle of each track-segment. Just drag them to a new position to create
new nodes. This simplifies the editing of tracks. 

If you click with the RIGHT mouse button on a node, a local popup menu will appear that allows you to
delete the node, adjust the node to the grid or to split the track into 2 separate tracks.

Whenever you select a track, the width of this track is displayed in the track-width field:

You may now adjust the width for the selected track (and for all other tracks that are selected). 
Whenever you have selected a track, the width-input field will be displayed in red. This indicates, that any
changes of this value will now causes changes on your layout. 

Created with the Standard Edition of HelpNDoc: Easy to use tool to create HTML Help files and Help web sites

Pads, Vias and Drillings
 
To place a pad select the corresponding mode from the left sidebar:
 

Sprint Layout offers several shapes for pads. The current shape is displayed on the button. To select
another shape, click to the arrow button right from pad button. 

If the option THROUGHPAD is selected, the pad will appear on both sides of the board automatically (on
multilayer boards they appear also on the inner layer I1 and I2). These pads (Vias) are indicated by a
different color.

Move the mouse cursor to the board while the pad mode is selected. Every click will add a pad to the
layout.

The pad mode may be aborted by pressing the right mouse button (or <ESC>).

3 different pads

http://www.helpndoc.com/help-authoring-tool
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Note:
The drilling of a pad is always free of any copper, thy can not be overlapped by any other element. So you
may draw a track over existing pads, but the drill-holes are still blank.
 
Tip:
Hold down the <CTRL> key of your keyboard, to turn off the grid-capture, if you have to reach positions that
are off the grid. 

The current size of the pad and the drilling is shown in the left sidebar below the mode-buttons:
 

Here you can change the current values at any time. 

Favorite list
For often used pad-sizes there is a favorite list available. Click with the mouse on the symbol left to the edit
field:

 A menu will appear and you have access to your favorite pad-sizes with just one click:

 
If the current value is not in the list, you may add it to the list with the "+" option.
If the current value is already in the list, the entry is marked.
You can delete unneeded entries with the Remove option.

 
Modify existing pads
To modify an existing pad, select the pad.
Whenever you select a pad, the pad-size is displayed in the left sidebar. The pad-shape is also displayed on
the pad-mode button:

You may now select another shape for the pad or adjust the pad-size or the drilling. The changes will be
made to all selected pads, in case that more than one pad is selected. 
Whenever you have selected a pad, the pad-size fields will be displayed in red. This indicates, that any
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changes to these values will immediately change your layout. 

If the properties-panel is visible you can edit the pad here:
 

 
Pure drillings 
Pure drillings are simple holes without any copper ring. These drillings are normally used to mount
components on the board. Set the inside diameter and the outside diameter of a pad to identical values to
create a drill hole without copper. Such drill holes are indicated clearly by a cross. 

Trough pads (vias) 
A trough pad (also called via) is a pad that appears on both sides of the board automatically. A trough pad is
used to connect tracks from both sides of the board. Trough pads are indicated by a special color.
If you want to place a through pad, select the option Through pad from the popup menu of the pad-shape
button. Drawing and editing through pads is exactly like editing ordinary pads. 
You may also select an existing pad and change the Through pad option in the properties-panel.
 
Tip:
You can change a simple pad into a through-pad and vice versa at any time. Just select the pad(s) and
press the <F12> key.

Thermal pad
The option Thermal pad is only available if the layer has an automatic ground-plane. A thermal pad is
looking like this:
 

 
Thermal pads are easier to solder, because they are not completely surrounded with copper.

There are some more properties for thermal-pads:

mk:@MSITStore:F:\WINDOWS\PROJEKTE\CD-ROM\DEMO\Sprint-Layout_UK\layout50.chm::\ThePopertiespanel.html
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You can change the width and the positions of the little tracks which connect the thermal-pad to the ground-
plane.

If the thermal-pad is also a through-pad (via), you have the possibility to change the positions of these little
tracks for each layer separated. To do this, select the option Layer individual. Your settings for the
positions are now only valid for the current active layer. So, you will have to change the active layer, to edit
the positions for each layer.

Created with the Standard Edition of HelpNDoc: Free HTML Help documentation generator

SMD-Pads

To place a SMD-pad select the corresponding mode from the left sidebar:
 

 
Move the mouse cursor to the board while the SMD-pad mode is selected. Every click will add a SMD-pad
to the layout.

The pad mode may be aborted by pressing the right mouse button (or <ESC>).

 
3 different SMD-pads

Tip:
Hold down the <CTRL> key of your keyboard, to turn off the grid-capture, if you have to reach positions that

http://www.helpndoc.com
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are off the grid. 
 
The current size of the SMD-pad is shown in the left sidebar below the mode-buttons:
 

 
Here you can change the current size at any time. 
A click on the little arrows below the edit fields will exchange the both values.

Favorite list
For often used SMD-pad sizes there is a favorite list available. Click with the mouse on the symbol left to
the edit field:

A menu will appear and you have access to your favorite SMD-pad sizes with just one click:

 
If the current value is not in the list, you may add it to the list with the "+" option.
If the current value is already in the list, the entry is marked.
You can delete unneeded entries with the Remove option.

 
Modify existing SMD-pads
To modify an existing SMD-pad, select the SMD-pad.
Whenever you select a SMD-pad, the SMD-pad-size is displayed in the left sidebar.

You may now adjust the size of the SMD-Pad. The changes will be made to all selected SMD-pads, in case
that more than one pad is selected. 
Whenever you have selected a SMD-pad, the SMD-pad-size fields will be displayed in red. This indicates,
that any changes to these values will immediately change your layout. 

Created with the Standard Edition of HelpNDoc: Free HTML Help documentation generator

Circles / Segments

http://www.helpndoc.com
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To draw a circle select the corresponding mode from the left sidebar:
 

 
Now you can click on your layout to define the center of the new circle and draw the circle with still pressed
mouse-button to the desired size. The track-width of the circle corresponds to the current track-width.

The circle-mode may be aborted by pressing the right mouse button (or <ESC>).

 
Tip:
Hold down the <CTRL> key of your keyboard, to turn off the grid-capture, if you have to reach positions that
are off the grid. 

 

The current track-width of the circle is shown in the left sidebar below the mode-buttons:
 

 
Here you can change the current track-width at any time. 
A width of "0" is always drawn as the thinnest line that is supported by the device (screen or printer).

Modify existing circles
Whenever you select a circle, the track-width of this circle is displayed in the track-width field:

You may now adjust the track-width for the selected circle (and for all other circled that are selected). 
Whenever you have selected a circle, the width-input field will be displayed in red. This indicates, that any
changes of this value will now causes changes on your layout. 

Segments
Every circle can be also a segment. Therefore there are two changing-points for each circle
to define the start- and the end-position of the segment. Both points are initialized at a "3
o'clock"-position (means 0°). You can drag these changing-points (displayed as blue points)
to the desired positions. 
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A numeric setting of the circle or segment properties can be made in the properties-panel. Just select the
circle(s) and edit the properties:

Created with the Standard Edition of HelpNDoc: Free HTML Help documentation generator

Rectangles

To draw a rectangle select the corresponding mode from the left sidebar:
 

 
Now you can click on your layout to define the start-point of the new rectangle and draw the rectangle with
still pressed mouse-button to the desired size. The track-width of the rectangle corresponds to the current
track-width.

The rectangle-mode may be aborted by pressing the right mouse button (or <ESC>).
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Tip:
Hold down the <CTRL> key of your keyboard, to turn off the grid-capture, if you have to reach positions that
are off the grid. 

 

The current track-width of the rectangle is shown in the left sidebar below the mode-buttons:
 

 
Here you can change the current track-width at any time. 
A width of "0" is always drawn as the thinnest line that is supported by the device (screen or printer).

Filled rectangles
If you click on the little arrow on the right of the rectangle-button, you can select if you want to draw a
rectangle as a track, or as a filled area.

2 rectangles

After the rectangle is created, it is either made of a simple track or a simple zone (if filled).
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Zones
 
Zones are filled areas (polygons). Zones, that are drawn on a copper layer and connected to certain signals,
are also called planes (ground plane, power plane, etc.). The outline of a zone is drawn in the same way as
tracks, where the outline width determines the radius of the zone corners. Sprint Layout closes and fills the
polygons automatically. 

To draw a rectangle select the corresponding mode from the left sidebar:
 

 
If you move the mouse to the layout, you will see an additional point in the size of the current track width.
This point defines the starting point of your new zone. Click with the mouse to confirm the starting point.
From now on, there is always an angled track-segment sticking on your mouse-cursor. With additional
clicks you can now draw your zone.

http://www.helpndoc.com/help-authoring-tool
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If you want to finish drawing, just click with the RIGHT mouse-button. You can now start to draw a new
track. If you want to exit the track-mode just click again with the RIGHT mouse-button, or press <ESC>.
The zone will be closed and filled automatically. Note, that you will need at least three points for a zone.
Otherwise the zone will not be created.

 
Bend mode
While drawing a zone, you can change the bend mode by pressing the <SPACE> key. There are 5 bend-
modes altogether and you can simply toggle through these modes with the <SPACE> key.

 

Tip:
Hold down the <CTRL> key of your keyboard, to turn off the grid-capture, if you have to reach positions that
are off the grid. 

The current track-width of the zone is shown in the left sidebar below the mode-buttons:
 

 
Here you can change the current track-width at any time. 

Modify existing zones
To modify an existing track, select the zone:
 

The nodes of the zone will be drawn as solid blue points. You may click on a node and drag it to a new
position.

Virtual nodes 
These nodes are located in the middle of each track-segment. Just drag them to a new position to create
new nodes.

If you click with the RIGHT mouse button on a node, a local popup menu will appear that allows you to
delete the node or adjust the node to the grid.

Whenever you select a zone, the track-width of this zone is displayed in the track-width field:

You may now adjust the width for the selected zone (and for all other tracks that are selected). 
Whenever you have selected a zone, the width-input field will be displayed in red. This indicates, that any
changes of this value will now causes changes on your layout. 

 
If the properties-panel is enabled, you can make some additional settings:
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Zones can not only be filled solid, but also hatched.
Select the Hatched option and set the thickness of the hatch.
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Special forms
 
Here you can create different geometric figures:
 

· Equilateral polygons

· Spirals

· Frames

The polygons can be used excellent as a construction-help. For example, if you need a component with 12
pins arranged in a circle, you can create a 12-sided-polygon, place a pad on every edge and delete the
polygon. 

Spirals are mostly needed on hf-boards.
 
To create a special form select the corresponding mode from the left sidebar:
 

 
 
Create a polygon
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Here you can just set the desired parameters. You will always see the effect of the parameters in the
preview.

If you confirm with OK, you can place the polygon on your layout. Move the mouse over the layout and you
will see a copy of your generated polygon. To place the polygon just click the left mouse-button. WIth the
RIGHT mouse-button or <ESC> you can cancel the action.

 
Create a spiral
 

 
Here you can just set the desired parameters. You will always see the effect of the parameters in the
preview.

If you confirm with OK, you can place the spiral on your layout. Move the mouse over the layout and you will
see a copy of your generated spiral. To place the spiral just click the left mouse-button. WIth the RIGHT
mouse-button or <ESC> you can cancel the action.
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Create a frame
 

 
Here you can just set the desired parameters. You will always see the effect of the parameters in the
preview.
With Autosize you can automatically adjust the frame-size to your current board-size.

If you confirm with OK, you can place the frame on your layout. Move the mouse over the layout and you will
see a copy of your generated frame. To place the frame just click the left mouse-button. With the RIGHT
mouse-button or <ESC> you can cancel the action.

Tip:
Hold down the <CTRL> key of your keyboard, to turn off the grid-capture, if you have to reach positions that
are off the grid. 
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Text labels
 
To place a text label select the corresponding mode from the left sidebar:
 

 
The following dialog appears:
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Here you can enter your text and set additional parameters like height, style, orientation, etc.
 
Confirm your parameters, and you can place the text with the left mouse-button. 
The text mode may be aborted by pressing the RIGHT mouse button (or <ESC>).

Tip:
Hold down the <CTRL> key of your keyboard, to turn off the grid-capture, if you have to reach positions that
are off the grid. 

2 Text labels

A text on the bottom site of your board (C2 or S2) should always be mirrored. Because you look "through"
your board at design-time, you will see the bottom site always mirrored. Sprint-Layout will do the mirroring
automatically for you.

Automatic
With the Automatic function you can create text labels with consecutive numbers (like R1, R2, R3, ...). The
number will be added to your text automatically. After you have placed a text, you can place the next text
with the next number immediately. You can be abort the automatic mode by pressing the RIGHT mouse
button (or <ESC>).

Modify existing text labels
To modify an existing text label, just double-click on this label. and you can edit its parameters.

If the properties-panel is visible you can also edit the text label right here:
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Using the clipboard
 
The clipboard is a very useful tool in almost every windows application. The clipboard is a kind of container,
which you can use to copy elements of your layout. The following functions will use the clipboard:
 

· Cut

· Copy

· Paste

· Duplicate
 
You can find these commands in the Edit menu. Each command has also a button in the toolbar. You can
also call these commands from the local popup-menu.
 

Cut
Copies all selected elements from your layout to the clipboard. After that the selected elements will be
deletes from your layout.
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Copy
Copies all selected elements from your layout to the clipboard.
 

Paste
Copies the content of the clipboard to your layout.
The clipboard elements will "stick" on your mouse cursor. You can place them with a single click.
 

Duplicate
Performs COPY and PASTE in one single step.
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Zoom
 
The zoom function is a very important function of Sprint-Layout. Only this function makes it possible to take
a look at the complete layout, and then zoom in to view a special place in large format.

Zoom with the mouse-wheel
The most simple and convenient way to zoom and navigate is to use the mouse-wheel.
If your mouse is over the layout, you can zoom in or out with the mouse-wheel. If you zoom in, the current
mouse-position will be centered automatically. So you can navigate very easy through your layout, just
zoom a little bit out and in.

All other possibilities to zoom are obsoleted and not economically, but
nevertheless they are possible:
 
The zoom mode
To adjust the zoom click to the corresponding button in the left sidebar:
 

 
The mouse cursor changes to a magnification glass. A click with the left mouse button increases the zoom.
The right mouse button decreases the zoom. You may also draw a frame to select the detail to be zoomed. 

There are additional zoom-functions, which you can use in the toolbar: 

Zoom previous 
Takes you back to the previous zoom.
 

Zoom board 
Adjusts the zoom so that the board fits to the screen.
 

Zoom objects 
Adjusts the zoom so that all objects of the board fit to the screen.
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Zoom selection 
Adjusts the zoom so that all selected objects fit to the screen.  
 
 

The Board-Zoom 
In addition to the normal zoom functions you can use the Board-Zoom feature of Sprint-Layout to select the
displayed region of your board in a very intuitive way. You can activate or deactivate the Board-Zoom in the 
General Settings. If the Board-Zoom is activated, it will be displayed on the left sidebar:
 

 
The dark green panel symbolizes your complete board, and the light green panel your actual displayed
region. You can click on the light green panel and move the region. The displayed region in the editor will
follow immediately. So you can "travel" all around your board. 
With single mouse-clicks on the light green panel you can also adjust the zoom: 

· Click left to zoom in the board, the light green panel will become smaller 
· Click right to zoom out of the board, the light green panel will become bigger 

You don't have to select the zoom mode, to use the Board-Zoom. You can use the Board-Zoom in every
mode at any time. 
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Rotate, Mirror and Align
 
You can rotate, mirror or align any element on your layout.
Use the following functions:

· Rotate

· Mirror horizontal

· Mirror vertical

· Align

· Snap to grid
 
You can find these commands in the Function menu. Each function has also a button in the toolbar. You
can also find these commands in the local popup-menu.
 

Rotate
This function rotates all selected elements clockwise in a free definable angle. Click on the little arrow to
define the desired rotation-angle.
You can rotate either single elements or even complex selections.

Tip:
If you press the SHIFT-key, the selected elements will rotate anticlockwise.

 

http://www.helpndoc.com


31 / 86

Mirror
These functions mirror the selected elements either vertical or horizontal.
 

Align
This function adjusts all selected elements. You can select between top, bottom, left, right, horizontal-
centre or vertical-centre alignment.
 

Snap to grid
This function forces all selected objects to grid positions. Caution: This may change the distance of objects
that are not grouped. The relative positions of objects that are combined to groups will not be affected. In
case of groups the whole group is moved.
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Build and Split Groups
 
Elements of a layout can be combined to groups. Groups make it easier to select, move or edit all members
of a group with a single operation. Groups also protect their elements against unwanted changes. You can
not delete a single element that belongs to a group. At least two elements are necessary to create a group.
Groups can contain any elements of a layout, even other (sub-) groups. 

If you have to delete or modify individual elements of a group, you must first split the group. Only the top-
level group is affected when a group is split. Subgroups stay unaffected, but you may repeat the split
operation to split a subgroup.
 
Tip:
You can select a single element of a group, by pressing the ALT-key and then click on the element to
select it.

Call Build group or Split group from the Functions menu or from the corresponding buttons in the toolbar.
These functions are also available from the local popup menu (right mouse button) of the editor. 

Sprint Layout will group elements automatically when they are pasted from the clipboard or from the macro-
library. This makes it easier to place the elements. You may split these groups as well as any other groups.
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Connections (Rubberbands)
 
With the connections you can connect pads or SMD-pads of your layout. This is helpful not to forget to
route tracks. 

The connections are also very important for the work with the integrated autorouter. The autorouter uses
these connections to route tracks. 

The connections, displayed as thin rubberband-lines, are also helpful to find a suitable position for
components. You may use them to avoid crossing tracks when placing components on the board. 
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To place connections on your board, activate the connection-mode with the corresponding button from the
left sidebar:
 

 
Connections can only be drawn between 2 pads or SMD-Pads. Just click on the first pad, you want to
connect. After that, a rubberband "sticks" on your mouse cursor. Now click on any other pad to finish the
connection. Pads will light up when they are touched to make connecting easier. 
Click with the right mouse button, to abort the process.

Example of 3 connections
 

Delete existing connections
To delete an existing connection, you will have to activate the connection-mode. If you now move the mouse
over an existing connection, the connection will be highlighted and the mouse-cursor will change to x. You
can now click to delete the connection.

 

Delete connections automatically 
Sprint Layout is in the position to find out whether two pads are connected by the layout or not. This makes
it possible to remove connections between connected pads (routed tracks) automatically. Call Remove
Connections (Rubberbands) from the Extras menu or from the corresponding button in the toolbar. 
This function examines every rubberband-connection and removes it, if the connection between two pads
has already been routed. Sprint Layout considers also trough pads for double-sided boards. The function will
inform you about removed and remaining connections when the process is finished.
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The Autorouter

A simple point-to-point autorouter is integrated in Sprint-Layout. This autorouter is able to connect two
points of your layout. These two points are defined with a connection (rubberband).  The autorouter is not
designed, to generate whole boards at once. This is usually not possible. To create a proper layout, you
have to design it mostly by yourself. 

The autorouter in Sprint-Layout is designed as an easy-to-use autorouter. You don't have to set obscure
specifications and options. The autorouter is as simple as the whole software itself. 

To use the autorouter, select the corresponding button in the left sidebar:
 

 
This little panel appears on the top of your layout:
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Track width:
Here you can set the width of the track that the autorouter should use.
 
Minimum distance:
Here you can define the minimum distance to other elements of your layout, that the autorouter should use
to route the track.

Orientate on current grid:
These option forces the autorouter to use the current grid (or factors of it) for the new routed track. The
resulting grid the autorouter will use is displayed below this option.

Autoroute a connection
You can select the desired connection with the mouse. If you move the mouse over a connection, the
connection will be light up. With a simple click you can now "autoroute" this connection. 

Example with 2 autoroutes

The autorouted track will be placed on the active layer. Make sure that the correct layer is activated. 

The autorouter is searching for the shortest way to route the track. It takes care of the minimal distance
between the elements on his way: 

· Elements on the active layer 
· Drill-holes 
·

If the autorouter finds a way, the track will be created. Otherwise you will get a message in the autorouter-
panel 
Autoroutes are indicated by an inner stripe. So you can distinguish between autorouted tracks and normal
tracks. 
 
Resolve an autoroute
You can resolve an autorouted track back to a connection. Just click on the autoroute, and you will get the
original connection.
 
Modify an autoroute
You can also edit the autorouted track just like a normal track. You can adjust the width, move the corners,
etc.
 
Tips for using the autorouter 
If you have many connections to route, start to autoroute the shortest and easiest connections first. You
may realize, that one autoroute is "blocking" some other good routes for other connections. Just resolve this
autoroute and try the other connections first. Play with the sequence of the connections, to get the best
results. 

The autorouter can more likely find a route if you select a small track-width and a small distance. Try to
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change these values, if the autorouter fails to route a connection. Anyway you can edit autorouted tracks, if
necessary.

Created with the Standard Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

The Test-Function
 
This is a very useful function to test the electric connections on your layout. Sprint-Layout can find
connected tracks, pads and other areas of a board. This makes it easy to check the signal flow of the
layout. Connected areas will light up. 

Activate the test mode with the corresponding button on the left sidebar:
 

 
The mouse cursor will now appear as a "signal injector”. Simply click to any position of your layout and
Sprint-Layout will find all tracks, pads and other areas that are connected to the click position. Connections
via through-pads and tracks from both sides of the boards are also considered in test mode. You may now
click to another position or cancel the test mode with the RIGHT mouse button or <ESC>. 

Note:
The test will also consider connections that are made with through-pads (vias) on the opposite site of your
board.

Blinking test-mode
The connected elements will be displayed in a blink-mode. This helps you to identify the connected
elements. You can disable the blink-mode in the General-Settings of Sprint-Layout.

Consider connections (rubberbands) in test-mode
You may define, that the test-mode also considers existing connections (rubberbands). In this case, all
elements which are only connected by a connection (rubberband) will be also recognized as "connected".
You can set this option in the General-Settings of Sprint-Layout.
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The Measure-Mode
 
With this function you can easily measure distances and angles on your layout. 

To select the measure-mode, just click on the corresponding button in the left sidebar:

 
You can now click on any position on your layout and draw a frame:
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You will see the following values:
 

· X: X-Coordinate

· Y: Y-Coordinate

· dX: Distance in X-Direction (horizontal distance)

· dY: Distance in Y-Direction (vertical distance)

· Dist: Absolute distance (diagonal distance)

· Angle: Angle of the diagonal distance

With these values, you can measure your layout exactly. Measurements will become more accurate, when
details are zoomed. 
With a click on the RIGHT mouse-button (or <ESC>) you can exit the measure-mode.
 
Tip:
Hold down the <CTRL> key of your keyboard, to turn off the grid-capture, if you have to reach positions that
are off the grid. 
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The Automatic Ground-Plane
 
This function fills unused areas of a layout with copper automatically. This accelerates the corroding
process and saves corroding material. You may also use this function to create a screen for HF-boards.
Please consider that the function creates an area that is NOT connected to any signal of the board. So you
may have to connect the area to GND yourself, if necessary. 

The automatic ground-plane is available for each copper-layer of a board. To activate or deactivate the
ground-plane, click to the corresponding button on the bottom of the editor: 
 

 
The panel will open:
 

The automatic ground-plane is now activated for the active layer and will be displayed on your layout. 

You may turn on/off the ground-plane whenever you like, without any loss of information. 

You may adjust the distance between the ground-plane and existing tracks, pads and other elements. The
distance is adjustable for each individual element of the layout with the input field on the right of the ground
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plane button (only visible if ground plane is activated). To change the distance of an existing element, select
this element first and then change the value. You will see the result immediately on your layout.

Tip:
If you set the distance to "0", the element will contact with the ground-plane. So you can place either pads
or tracks to the ground-plane which are connected with the ground-plane.

 
Cut-out areas
You can create cut-out areas on your layout. These areas will NOT be filled by the ground-plane function. 
To create a cut-out area, please click on one the hatched buttons below the edit-field for the distance. The
left button is to create a rectangle cut-out area, and the right button is to create a polygonal cut-out area.
Now you can create one ore more cut-out areas on your ground-plane. The drawing of cut-out areas areas is
absolute identical with the drawing of normal rectangles zones. You can edit the cut-out areas just like
normal rectangles or zones, by moving and editing the corners of the cut-out area. 
 
Caution: 
Depending on the distance between tracks and pads, the auto-generation of a ground plane may lead to
narrow copper areas. In worst case the copper could detach from the basic material and cause shortcuts, or
narrow connections may not "survive” the corroding process.
 

Figure: Narrow copper area between tracks

Please check your layout carefully when using the ground plane function. To avoid narrow copper areas
move tracks to another position, change the distance to the ground plane or use cut-out areas. 
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Use a Scanned-Copy as an Original

You can load a bitmap in the background of your layout. This bitmap can be a scanned-copy from an
existing layout. You can use this bitmap as an original to trace the layout.

The bitmap must be available as a bitmap file (BMP or JPG). The resolution should be between 300-600 dpi.
A pure B/W color depth is recommended, but not absolutely necessary.
 
 

 Load a bitmap to the background
Select the command Scanned copy... from the Extras menu, or click the corresponding button in the
toolbar:
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Board side 1 (Top) / Board side 2 (Bottom)
Here you can select the desired board side for the bitmap.
 
Load bitmap...
Opens a file dialog to select the bitmap file. The file must be a bitmap file in BMP or JPG format.
 
Delete Bitmap
Here you can remove a loaded background bitmap.
 
Show bitmap
This option shows or hide the loaded background bitmap.

Resolution
Sprint-Layout tries to recognize the resolution of the bitmap file automatically. But unfortunately in many
cases this value is not or not proper set in the bitmap file, so you will have to check this value. If the bitmap
is not displayed in the true scale, you will have to edit this value until the bitmap is displayed in true scale.

X/Y-Offset
Here you can define an offset to move the bitmap on your layout. Adjust these values to get a proper
position in relation to your current grid.

You can call this dialog at any time, to change these parameters.
 
 
Trace an original
If you want to create a Sprint-Layout file from a scanned copy of a layout, load the bitmap file in the
background and then trace the layout by hand. Make sure that the bitmap is displayed true to scale. To
adjust the X- and Y-Offset we recommend small grid distances (1/2 or 1/4 of the default grid) and large zoom
magnification. Try to move the bitmap to a position that fits the grid best possible. Try different grids and
zoom magnifications when tracing a layout. For objects that are completely out of the grid you may use the
CTRL-key to turn of the grid capture temporary. 
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If you have a scanned copy visible on your layout, 2 additional buttons appear at the bottom of the editor:
 

 
With these buttons, you can show the bitmap exclusive or hide the bitmap temporary (as long as you
press the button). This options may help you to keep the clearness in some cases. 
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Tile / Arrange Circular

With this function you can copy elements, and arrange these copies as tiles or circular.

Select the desired elements, click with the RIGHT mouse-button on the selection and select the command 
Tile / Arrange circular...

Tile

Just enter the number of the desired horizontal and vertical tiles and also the distances.
You will always see the result of your parameters In the preview.
If you click on OK, the action will be performed and you get the result on your layout.

Arrange Circular
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Number total
The total number of copies.

Angle
The angle between the separate copies.

Radius
The radius of the imaginary circle, to arrange the copies.

Rotate elements
With these option you can define, if the copies should rotate itself.

Startpoint of circular segment
The startpoint of the imaginary circular segment is in general the center of the selected elements (0/0). You
may set this startpoint to another position. You can also set the startpoint to the center of a pad. You can
select the desired pad with the 2 arrow-buttons.

You will always see the result of your parameters In the preview.
If you click on OK, the action will be performed and you get the result on your layout.
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The Photo-View
 
The photo-view lets you take a look at your board as if it was already manufactured, with drillings, silk
screen, etc.
This helps you to find typical mistakes like wrong mirrored components or text.
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To activate the photo-view, just click on the corresponding button in the left sidebar:
 

 
This little panel appears on the top of your layout:
 

 
Top side C1/S1
This option shows the top side of your board. The layer C1 and S1 are visible on the top of your board.
 
Bottom side C2/S2
This option shows the bottom side of your board, just as if you have turned your board. The layer C2 and S2
are visible on the bottom of your board.

With silkscreen
With this option you can show or hide the silkscreen of your board.
 
X-Ray 
With this option, the board becomes a little transparent, so that the other board side shines through.

Board
Here you can select a predefined color for the board.

Soldermask
Here you can select a predefined color for the soldermask.
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Macros

The component library of Sprint-Layout consists of so-called macros. Macros are small layouts of recurrent
elements (mainly components like IC's, resistors, transistors, etc.). 
Sprint Layout is delivered with several predefined macros. You may use these elements to create your
layout. If a special macro is missing, it is easy to create your own macro and add it to the library. See
also... 
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· The Macro-Library

· Create your own Macros
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The Macro-Library

You can show or hide the Macro-Library of Sprint-Layout at any time.
Just click on the corresponding button in the toolbar:
 

 
The macro-library will appear on the right side of your layout:

 
Select a Macro
There is a structured tree-view of all macros at the top. You can expand or collapse each group by clicking
on the little [+] or [-] buttons.

In an expanded group you can see all contained macros or subgroups. If you select a macro, you will see a
preview of this selected macro at the bottom of the macro-library.

If you want to use this macro in your layout, just move the mouse on the preview of the macro, and draw it
per Drag&Drop to your layout. Just click on the macro, keep the mouse-button pressed and move the
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mouse to the desired position on your layout.

 
Additional Macro-Functions
There are some buttons with important functions above the macro-preview.

 
Board-Side of the Macro
With this button, you can change the board-side of the macro. The macro can either placed on the top or on
the bottom side of your board.

Through-Pads (Vias)
If this button is pressed, all pads of the macro will change to through-pads automatically.

Rotate
Use this button to rotate the macro 90° clockwise.

 

Delete Macro
With this button you can delete the currently selected macro.

Save as Macro
With this button, you can save the currently selected elements on your layout as a new macro.

as Component
If this option is activated, each macro that you will take on your layout will be created as a component.

 
Tip:
You may change the width of the macro-library. Move the mouse to the boarder line between the library and
the editor. The mouse cursor changes to a double arrow. This indicates that you can move the border,
while you hold down the left mouse button.

Created with the Standard Edition of HelpNDoc: Free CHM Help documentation generator

Create your own Macros
 
There is no difference between drawing a macro or drawing any other layout. Use the copper layer (C1,C2)
for pads and tracks and the silk screen layer (S1, S2) for component outlines. Outlines are simply drawn
with ordinary layout elements (circles, tracks, etc.) on the silk screen layer.

 
Example:
You want to create a macro for a simple 14-pin DIL IC.

(This is only an example. Of course, a 14-pin DIL-IC is already included in the macro-library.)
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1. Draw the Macro
Place the 14 pads on the layer C2 (copper-bottom) in the right grid distance. You may create a square-pad
for the pin1, to identify this pas as "Pin 1".

Change the active layer to S1 (silkscreen-top) and draw a frame around the pads. Just use a track or the
rectangle-mode to draw this frame. You may draw an additional mark to identify the notch of the IC.
 

 
That's it, your macro is ready. You will now have to save it and add it to the macro-library.

2. Select the macro-elements

Change to the edit-mode and select the elements by drawing a frame around all elements.

All elements are now selected.

3. Save the Macro

To save the macro call the command Save as Macro... from the File menu.
You can also click on the corresponding button in the macro-library.

A file dialog will appear. The selected directory-path in this dialog corresponds to the currently selected
macro-group in the macro-library. If you want to save the macro in another macro-group, you will have to
change the directory-path to the corresponding directory.

Enter a valid filename for your new macro. The suffix ".lmk" (which is the default suffix for all macros) will be
added automatically.
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You can now save your macro, and it will appear in the macro-library.

Created with the Standard Edition of HelpNDoc: Free help authoring tool

Components

A component is almost equal to a normal macro. It contains a group of elements, but in addition it contains
a set of special data, which allows Sprint-Layout to manage the components. Sprint-Layout can create
component-lists or even Pick+Place files (for automated SMT placement).

For Further informations read also...

· Create a Component

· Modify / Disintegrate a Component

· Components in the Macro-Library

· The Component-List

· Pick+Place Data

· Export Component Data

Created with the Standard Edition of HelpNDoc: Full featured multi-format Help generator

Create a Component

A component is almost equal to a normal macro. It contains a group of elements, but in addition it contains
a set of special data, which allows Sprint-Layout to manage the components. Sprint-Layout can create
component-lists or even Pick+Place files (for automated SMT placement).

Every macro or even every selection can become a component.
To change a macro into a component, click to the macro with the RIGHT mouse-button and then select the
command Component...

http://www.helpndoc.com/help-authoring-tool
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Each component has 2 individual text-labels: Identifier (ID) and Value. You can edit these texts here.
In general the text-labels appear on the silkscreen-layer of the macro, but you may change also the layer
here.
You can also define the visibility of these text-labels. Even if the text is invisible, the data is still available,
e.g for the component-list.
The button Align text automatically aligns the 2 text labels Identifier and Value to the default positions at
the top/left of the component.

If you confirm with OK, the component will be created:

A Macro becomes a Component

If the component is using Pick+Place data, you will always see a little cross in the center of the component.

You may move the Identifier and the Value to other positions. If you click and draw these text-labels, the
rest of the component will stay on its position. To select or move the complete component, just click on any
other element of the component.

You can call the component-dialog at any time to edit the component-data. Just double-click on the
component, or click with the RIGHT mouse-button on the component and call the command Component...

Disintegrate a Component
You can disintegrate a component at any time. The component then becomes a normal group of elements,
and all component-data is lost.
To disintegrate a component call the component-dialog for the component and click on the button 
Disintegrate component.

Created with the Standard Edition of HelpNDoc: Full featured Help generator

Modify / Disintegrate a Component

Modify an existing Component
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You can call the component-dialog at any time to edit the component-data. Just double-click on the
component, or click with the RIGHT mouse-button on the component and call the command Component...

Tip:
You can even select several components and change their components-data. In this case, every change in
the dialog will be marked with a blue color. You can assign these marked changes to all other selected
components after you have confirmed the dialog. So you can e.g. change the text-height for all components
at a glance.

Disintegrate a Component
You can disintegrate a component at any time. The component then becomes a normal group of elements,
and all component-data is lost.
To disintegrate a component call the component-dialog for the component and click on the button 
Disintegrate component.

Created with the Standard Edition of HelpNDoc: Easily create Help documents

Components in the Macro-Library

If you take a macro from the macro-library, you can define that this macro will be inserted as a normal
macro (just a group) or as a component.
If you want to add all new macros as a component, activate the option Add as component in the macro-
library.

http://www.helpndoc.com/feature-tour
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Every macro that you draw from the library will now be created as a component. After you have placed the
macro, the component-dialog appears automatically, and you can edit the component-data:

Predefine Component-Data in the Macro-Library
You can edit the component-data of the macros directly in the library. Just double-click on the macro-
preview and the component-data dialog will appear. You can now edit the component-data for the macro in
the library. Each time you use this macro, the component-data will be predefined with these data. If you
don't use this macro as a component, the predefined component-data will be ignored.

Created with the Standard Edition of HelpNDoc: Free CHM Help documentation generator

The Component-List

Sprint-Layout can create and manage a kind of component-list with any component used in your layout.
You can display or hide the component-list at any time. Just click on the corresponding button in the

http://www.helpndoc.com
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toolbar:

The component-list will appear on the right side of your layout:

You will find all used components in the above list.

If you select a component in this list, the component will be selected on your layout automatically. Vice
versa, if you select a single component on your layout, the corresponding entry in the component-list will be
selected as well.

You can double-click on an entry in the component-list to call the component-dialog and edit the
component-data.

Below the component-list there are options to display or hide some component-data in the list.
A click on the horizontal arrow will adjust the width of the component-list automatically.

Tip:
You may change the width of the component-list. Move the mouse to the boarder line between the
component-list and the editor. The mouse cursor changes to a double arrow. This indicates that you can
move the border, while you hold down the left mouse button.

Created with the Standard Edition of HelpNDoc: Easily create HTML Help documents

Pick+Place Data

A component can have additional data, which is especially necessary for automated SMT-placement. This
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data is also called Pick+Place data.
The additional data fields are:

· Rotation of the component

· Package of the component

· Center of component

You can edit this data-fields, if you click on the button Show Pick+Place Data in the component-dialog.
The dialog will then expands and show the additional data-fields:

Use Pick+Place Data
Here you can define, if the component should use the Pick+Place data. Normally the Pick+Place data is
only necessary for SMD components.
If a component uses Pick+Place data, you will see a little cross in the center of the component. This
indicates the usage of the Pick+Place data for this component.
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Rotation
Here you can define the orientation of the component on your layout.

The rotation defines the angle, which is used from a Pick+Place machine if it places the component on the
board.
The rotation is 0 (zero), if the component is vertical aligned and and its "pin1" or "+" is on top.
If a component is in any other orientation, the rotation depends on the board side, on which the component
is placed. Components on the top-side will rotate anti-clockwise and components on the bottom-side will
rotate clockwise.

Anyway, if the rotation of the component is set correctly, Sprint-Layout will manage the rotation-data of the
component automatically, if you rotate the component.

Package
Here you can edit the package of the component, like "DIL14" or "0204_MET". This data is not necessary at
all.

Center
The center defines the position, which is used from a Pick+Place machine if it places the component on the
board.
Normally the center is exactly in the middle of a component,

You can define the following parameters for the definition of the center:

Center Copper
Sprint-Layout sets the center to the center of an imaginary rectangle around all SMD-pads of the
component.

Center Silkscreen
Sprint-Layout sets the center to the center of an imaginary rectangle around all silkscreen-elements of
the component.

Center Copper+Silk
Sprint-Layout sets the center to the center of an imaginary rectangle around all SMD-pads and all
silkscreen-elements of the component.

X-/Y-Offset
If a component has an asymmetric shape, it may be necessary to define an offset to define the correct
center. The button 0/0 resets this offset to zero.

Created with the Standard Edition of HelpNDoc: Create HTML Help, DOC, PDF and print manuals from 1
single source

Export Component-Data

Sprint-Layout can export the component-data to a text file. So you can create a component-list or a Pick
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+Place file, which is necessary for an automated SMT placement.

To export the component-data, click the Export... button at the bottom of the component-list:

The following dialog appears:
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Exported Data
Here you can define the data, which will be exported.
You can also define the order of the data-fields in the right list. Just drag&drop these values to the desired
position.

Separator
Defines the character which is used to separate the data fields in a row.

Text for layer side
Defines the texts for the data-field Layer.
The default texts are Top and Bottom. The button Default resets the texts to the default texts.

X/Y - Position
Defines the unit and the format for the data-field Position.

Rotation
Here you can define, whether the data-field Rotation will be exported with an R prefix or not.

Filter
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Here you can choose, which components should be used for the export.

Preview
Here you can see exactly how your exported will look like.

Export...
Click on this button to export to write the component-data to a text file.

Created with the Standard Edition of HelpNDoc: Full featured Help generator

Printing
 
To print your layout, call the command Print... from the File menu, or click the corresponding button in the
toolbar:
 

 
You will get a preview of the printout, and the print dialog offers several print options. 
The preview will show immediately which effect an option will have to the printout.

 
The paper is displayed as a white page. The red frame is indicating the printable area of the paper. The size

http://www.helpndoc.com/feature-tour
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of this area is depending on your printer.
To adjust the position of the printout on the page just click on the paper and move the printout to the desired
position. What you see is what you get! 

On the left side of the preview you have several options:

Layer
Here you can select the layers, you wish to have on the printout. You can define a separate color for each
layer. Just click on the color-field on the right of each layer. You can only select the layer, which contains
printable elements. Empty layer are disabled.

You can define the printing-sequence with the 4 buttons below:

The top-side of the board is printed over the bottom-side.
Printing-sequence: C2 - I2 - I1 - C1 - S2 - S1 - O

The bottom-side of the board is printed over the top-side.
Printing-sequence: C1 - I1 - I2 - C2 - S1 - S2 - O

The top-side of the board is printed above the bottom-side.
Top printing-sequence: I1 - C1 - S1 - O
Bottom printing-sequence: I2 - C2 - S2 - O

The top-side of the board is printed next to the bottom-side.
Left printing-sequence: I1 - C1 - S1 - O
Right printing-sequence: I2 - C2 - S2 - O

Special layer
Here you can define solder-masks or drilling-plans.

Solder-mask
The solder mask is created from the pads and/or SMD-pads of the layout. Pads are printed with a
diameter that is raised by a defined value. The drillings of the pads are filled. 
With the button Options... you can define the properties of the solder-mask.

Drillings
This option prints the diameter and the positions of all drillings. 
With the button Options... you can define the text-height. 

Options
Here you can choose additional options for the printout:

Black & White
Produces a pure black & white printout. All colors will be ignored and set to black.

Mirror
The layout will be mirrored.
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Targets
This option adds 4 crosses in the edges of the layout to mark the corners of the board. 

Board outline
The option draws a frame to show the outline of the board. 

Scanned copy
If you have loaded a bitmap in the background of your layout, you can select this option to print this
bitmap together with your layout.

Invert
Produces a negative printout.

Grid
Shows a grid on the preview page. This helps you to position your printout on the paper. The grid will not
appear on the printout. 

Info line
Shows a little info-line at the bottom of the paper, The info-line includes file-name, board-name, scale,
date and time.

Scale
This option allows a scaling from 10% ... 500% of the printout.
Use the option 1:1 to print the real size.

Orientation
Select the orientation of the paper.

 
 
At the top of the preview there are additional functions:
 

Center
This will center the board in the middle of the page. 

Clipboard
This will copy the actual preview as a bitmap to the global clipboard. Other programs can paste this
bitmap. 

Tile
The option TILE prints the layout several time side by side to a page. Enter the number of repetitions for
X- and Y-direction and the distance between the layouts. 

Calibration
Some printers may need a calibration to produce printouts that are exactly true to scale.
Example: A line has a length of 200 mm but the printer produces a line with a length of 201 mm. In that
case enter a factor of 200 mm / 201 mm = 0,995 for correction. The printer will then print true to scale. 

Setup
Use the SETUP button to select and adjust the printer. The current printer is displayed in the headline of
the preview dialog. 

Print
Starts the printout immediately. 
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Cancel
Closes the preview and returns to the editor without printing. 
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Bitmap-Export
 
This function creates a bitmap file (*.bmp) that may be used with other applications.
The bitmap is created from the layers that are currently visible in the editor.

To create a bitmap file call Export -> Bitmap (*.bmp) from the File menu.

 

Format
Here you can select if the exported bitmap should be colored or black & white.

Resolution
Use the slider to adjust the bitmap resolution. Keep in mind that large resolutions (high quality) need more
memory resources, than lower values. The necessary memory is being displayed. Try to reduce resolution
as much as you can, with acceptable quality. This is most important with colored bitmaps. 

Close the dialog with OK to save the bitmap file.

Created with the Standard Edition of HelpNDoc: Free help authoring environment

GIF-Export
 
This function creates a GIF file (*.gif) that may be used with other applications.
The GIF file is created from the layers that are currently visible in the editor.
The GIF format is a compressed format, so the resulting file is much more smaller than a BMP file.

To create a GIF file call Export -> GIF (*.gif) from the File menu.
 

http://www.helpndoc.com
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Resolution
Use the slider to adjust the bitmap resolution. Keep in mind that large resolutions (high quality) need more
memory resources, than lower values. The necessary memory is being displayed. Try to reduce resolution
as much as you can, with acceptable quality. This is most important with colored bitmaps. 

Close the dialog with OK to save the bitmap file.

Created with the Standard Edition of HelpNDoc: Full featured multi-format Help generator

JPEG-Export
 
This function creates a JPEG file (*.jpg) that may be used with other applications.
The JPEG file is created from the layers that are currently visible in the editor.
The JPEG format is a compressed format, so the resulting file is much more smaller than a BMP file.

To create a JPEG file call Export -> JPG (*.jpg) from the File menu.
 

 
Resolution
Use the slider to adjust the bitmap resolution. Keep in mind that large resolutions (high quality) need more
memory resources, than lower values. The necessary memory is being displayed. Try to reduce resolution
as much as you can, with acceptable quality. This is most important with colored bitmaps. 

Close the dialog with OK to save the bitmap file.

Created with the Standard Edition of HelpNDoc: Free HTML Help documentation generator

Gerber-Export
 
Sprint Layout produces RS274-X Gerber-files that are used to exchange layout data with PCB
manufacturers. Gerber files are common to (almost) all manufacturers.
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You will need a Gerber file for each layer (Copper, Silk screen, Solder mask) to describe a PCB
completely. 

Call Export -> Gerber Export... from the File menu to create a Gerber-file.
The following dialog offers several options that are available with Gerber format:
 

 

Layer
Here you can select the layer, you want to export. Each layer will exported in a separate Gerber file.

Filenames of the Gerber files
The Gerber-filename of each layer is displayed next to the layer. Each Gerber-filename contains 2 parts:

Filename + File-Extension  ->  Example1_copper_bottom.gbr
Filename + File-Extension  ->  Example1_silkscreen_top.gbr
...



59 / 86

In this process the filename is the same for all layers, and the file-extension is different for all layers.

Filename:
Here you can enter a common filename for the Gerber files. This will automatically change all Gerber-
filenames.

File extensions...
The file extensions of each layer are predefined. You may change these extensions here:

Here you can edit the extensions for the Gerber-filenames.

Options 

Mirror
Mirrors the output of the layer. This option is mostly unnecessary.
 
Include frame (board size)
This option adds a frame in the current board size.

Punch drill holes
This options punches all drill holes of pads, which means that the inside diameter of pads is free from
copper. Usually this option is NOT necessary. Drilling the board will punch the pads anyway. This option
may be helpful if you drill the board by hand, but some manufacturers get in trouble with this option
selected. 
 
Center punch (0,15 mm)
This option is only available with the option Punch drill holes. This options puts only tiny marks to the
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center of copper pads, which make it easier, to drill the board by hand. 
 

Offset of solder mask
These options are only available if you have select a solder mask. You can adjust the offset of the pads or
SMD-pads separately. You can even select if you want to export the solder mask for normal pads and/or
SMD-pads (or even other elements, if you have included them to the solder mask).
The solder mask should be a little bit bigger than the copper. So you can adjust the offset for pads and
SMD-pads here.

Offset of SMD mask
This option is only available if you have select a SMD mask. You can adjust the offset of the SMD-pads
SMD-pads here.

Output-Directory
Here you can see the the currently selected output-directory for the gerber-files.
You can change this directory with the Change... button on the right.

Create Gerber files...
If you click on the button Create Gerber files... the Gerber files will be created and saved in the currently
selected output-directory.
In the list below, you can see a kind of protocol for each generated gerber file.

 
Tip:
Contact your manufacturer to clarify any obscureness.
Many manufacturers support the Sprint-Layout-format (*.lay). In this case, you won't have to create Gerber
files by yourself. You will just have give your layout-file to the manufacturer.
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Excellon-Export
 
An Excellon-file is used to exchange the drill data of a board with your manufacturer. It contains all
diameters and positions of your drillings. 

To create an Excellon file call Export -> Drill Data (Excellon)... from the File menu:
 

http://www.helpndoc.com/help-authoring-tool
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Selection 
You can select if you want to export only through-holes (vias), only simple drillings or both (therefore all
drillings).
The separate output of the through-holes (vias) is sometimes necessary for the manufacturing. 

Drill from...
Select from which board-side the coordinates will be generated. If you select to drill from the bottom, the
coordinates will be horizontal mirrored.
The option Sort drillings will sort the drillings in a geometrical manner. This will minimize unnecessary
routes of the drilling machine.

Unit of measurement 
Select the unit of the coordinates. Some machines may only work with inches. 
The option Delete leading zeros can be used normally without problems. If there is any trouble with it, you
can deselect this option.

Normally, the coordinates will be exported without any decimal point. The value of these coordinates
depends on the used number-format. Anyway, some machines expect the coordinates with decimal point. In
this case you can select the option Output with decimal point.
 
Special options
Here are some additional options for the Excellon file.
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Isolation-Milling

The isolation-milling is a special technique to produce PCB's with a CNC milling-machine. The tracks and
connections will be milled out of a solid copper board. Sprint-Layout supports the complete production of an
isolation-milled board, inclusive the isolation-channels, the drillings and the board shape. The result will be
exported in a plotfile in HPGL format (*.plt). This plotfile can be used from a CNC milling-machine to produce
the board.

To generate a plotfile for isolation-milling call the command Export -> Isolation milling (HPGL, *.plt)...
from the File menu.

With this dialog you will create the complete plotfile.

Isolation milling

· Milling width
Here you can enter the width of your milling tool. Sprint-Layout is using this width for a radius-correction
to calculate the isolation-channels.

Sprint-Layout will never calculate the isolation-channels in a way, that they will delete too much copper
from the board. The consequence is, that the minimum distance between 2 elements has to be the
specified milling-width. If not, the isolation-channel won't get through, see the right picture:

http://www.helpndoc.com/feature-tour
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In this case, you can decrease the milling-width, but note, that all other resulting elements will be a little
bit smaller if the real milling tool is bigger than the specified milling-width.

· C1 - Top / C2 - Bottom
Here you can select the board-side, you want to mill.

Normally, the top-side must not be mirrored and can be milled, just as is is drawn on ypur layout.
Normally, the bottom-side has to be mirrored, because you will have to turn the board to mill the bottom-
side. Depending on the turn-direction you will perform (horizontal or vertical), you will have to define the
kind of mirroring.

With the option Center punch (hole) you can define, if the milling-tool will go down in every drilling to
produce a little center punch. This function is included to allow a good alignment of CNC drills during the
drilling process and reduces the chance of the high speed hole drills from bending and breaking. 

Milling trails
This is for experts only!
The number of milling-trails is 1 per default. You may increase this number to get bigger isolation-channels
as the milling-width.

Drillings
Here you can define if and from which board-side you want to drill your board.
There are 3 possibilities to drill the board:

· Create all drillings with milling-cutter (CI-command)
All drillings will be created with the milling-cutter. The cutter dives into the board and moves in a circle to
create the drilling. With this technique, all hole-sizes bigger than the milling-tool itself are possible.
The milling-width of the used milling-tool is necessary for the accurate calculation of the circles.

· As drillings (PD-command) - all drillings with the same drill (pen)
All drillings will be written as normal pen-down and pen-up commands in the plotfile.
Sprint-Layout will ignore the different drill-sizes, and create one job for all drillings.

· As drillings (PD-command) - each diameter a new drill (pen)
All drillings will be written as normal pen-down and pen-up commands in the plotfile.
Sprint-Layout will sort all drillings and create one job for each drill-size.

Outline milling
Here you can define if and from which board-side you want to mill the outline of your board.
The outline of your board contains all tracks and segments on the outline-layer O.
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Note:
The milling-trails will be generated as normal vectors, without any outline-technique and radius-correction.
The board will become a little bit smaller all around by the half of the with of the used milling-tool. Vice
versa, a cut-out within your board will become a little bit bigger. If this tolerance can not be ignored, a radius-
correction will have to be made in the milling-application, or you will have to consider the used milling-width
while you are drawing the board outline in Sprint-Layout.

Reference holes (helps turn over the board exactly)
If you want to create a double sided board, you will have to turn the board during the production. This turn
over has to be made as exactly as possible, so that both board sides will be milled congruent. The reference
holes can help you to turn your board exactly. You can define 2 or 3 reference holes outside of your board.
Fix the board in these reference holes (e.g. with broken drills) to the carrier. If you turn the board, you can fix
it with the same reference holes to the carrier.

Click with the mouse on the reference holes in the edges to activate or deactivate a reference hole.
You will also have to define the distance of the reference holes from the board edge.

Text
Texts can be milled either outline or singleline.

Outline means, that the text will be outlined by a milling-trial.
Singleline means, that the text will be milled directly.

If you want to handle the texts separately, you may select some text-labels BEFORE you call the milling-
dialogue. In this case, you can set different options for the selected and for the unselected texts.

Options

· Mill only selected elements
If you select some elements before you call the milling-dialog, you can define, that only these selected
elements will be milled.

· Drillings with min. feed
Some milling-applications may ignore drillings, if they only perform a pen-down and a pen-up command,
without any movement. In this case, you can activate this option, and Sprint-Layout will generate a
minimal movement between pen-down and pen-up.

· Scale
Some milling-applications use a rounded scaling of 0,025 mm per HPGL-unit (instead of 0,0254 mm per
HPGL-unit). In this case you can select this scaling here.

The Joblist
On the right, you can see the joblist, which contains all milling-jobs of your plotfile, depending on the
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settings in the dialog. The resulting plotfile will contain all these jobs in the order as they appear in the
joblist. Sprint-Layout sorts this joblist in a proper sequence, but you may want to change the order of these
jobs by yourself. You can simply sort the jobs per Drag&Drop within this list.

The option Save joblist as textfile will save in addition to the plotfile a second small textfile (*.txt), which
contains all jobs that are included in the plotfile.

Create the plotfile
Click on Create... to generate and save your plotfile.
The generation process can take some time, depending on the complexity of your layout.

After that, you will see the calculated milling-trails on your layout. You can now check the result.

With this button you can change the width of the milling-trails. The milling trials can be either displayed as
thin lines or as lines in the width of the defined milling-width.

The button Delete outlines removes the milling-trails from the screen.

Created with the Standard Edition of HelpNDoc: Full featured Documentation generator

General Settings
 
Call the command General settings... from the Options menu.
Here you can change all settings for Sprint-Layout.
 
 
General Settings
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Base unit
Here you can set the base unit that Sprint-Layout should use: mm or mil (1 mil = 1/1000 inch).
You can also change this unit by clicking on the unit in the top/left edge of the rulers in Sprint-Layout.
 
Drillings
Here you can set the look of the drilling holes. You can select the background color (so that the holes look
transparent) or you can set the holes displayed in white (for a better identification).

Show Board-Zoom
Activates the little green Zoom-Window in the left sidebar, below the tool buttons.

Darken ground-plane
The automatic ground-plane will be displayed a little bit darker, so you can better differentiate is from the
rest of your layout.
  
Show ground-plane of all layers simultaneous
If this option is selected, you can see the ground-planes of all layers simultaneously. Otherwise only the
ground-plane of the current selected layer is displayed. The simultaneous display of all ground-planes may
be helpful, but this option also slows down the display speed, depending on the complexity of your layout.

Consider connections (rubberbands) in TEST mode
With this option, the test-function will consider all elements which are connected with connections
(rubberband)  as connected.

Blinking TEST mode
With this option, the result of the test function be displayed in a blinking-mode, so that you can better
identify the connected elements.

CTRL-Key necessary to capture values during selections
If you select an element, you can see its properties (like track-width or pad-size) in the left tool-panel.
Normally, you can "capture" these values by pressing the CTRL-key while selecting the element, so that
you can use these values for the next drawing action. If you want to capture these values permanent (even
without pressing CTRL), you can deactivate this option.
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Limit text height (track width min. 0,15 mm)
This option limits the text-height, so that the thickness of the track is never smaller than 0,15 mm. This
limitation is often useful, because a smaller size can not used while manufacturing a board with silk-screen.
 
Use origin in CAM-export (Gerber/Excellon/HPGL)
Normally, the origin will be used for every CAM-export. If you deactivate this option, the origin will be ignored
and the left/top edge will be used for the origin instead.

 
Colors
 

 
If you are not satisfied with the color-scheme of Sprint-Layout, you can define your own colors. 
You can select 4 different color-schemes: 

· Standard 
· User 1 
· User 2 
· User 3 

The color-scheme Standard is the predefined color-scheme of Sprint-Layout and it is not editable. 
The color-schemes User 1..3 are free color-schemes that you can define as you like. 
To change a color-scheme please select a user-scheme. Now you can change every color by clicking on
the little color-panels. 
The button Reset scheme to default resets all colors of the selected scheme to the default colors of
Sprint-Layout. 

Working-Directories
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You can define fixed working-directories for different file-operations in Sprint-Layout.
Every time you start Sprint-Layout, these directories will be set as default for the different file-operations.
 
With the "..." buttons, you can select a new directory.
 
Tip:
Leave a field empty, if you want Sprint-Layout to remember the last used directory.

With the option Use the same folder for all file types, Sprint-Layout will use only one common working-
directory for all file-operations. This option is useful, if you save your files project-related.

Macro-Directory
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The macro-directory is the directory which contains all macros and all additional macro-directories. Here are
all macros installed, which comes with the software. 
With the Change... button you can select another macro-directory. This is only meaningful, if you have
moved your original macro-directory to another drive or directory. 
The Reset button resets the macro-directory to the default setting.

 
Undo-Depth
 

 
The UNDO function in Sprint-Layout saves normally up to 50 steps, that you can undo if necessary. The
undo function has a memory consumption and it will need more memory if your layout is big. Normally this
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is no problem, but if you own an older PC and you notice that your system is working slowly, you can try to
decrease the undo-depth. 

Imax
 

 
The max. current-carrying of a selected track will be displayed in the properties-panel. 

This value is only a course approximate value. The real value is depending an many other factors like the
ambient temperature, the ventilation, etc. We won't guarantee this values. 

But still, we want to display this value as a coarse approximate. There are 2 important parameters to
calculate the max. current for a track: The copper-thickness of your PCB (in general 35µm) and the max.
temperature enhancement (recommended value 20°). You can change these parameters here, to adjust the
calculation of the current.
 
 
Hotkeys
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Here you can define new hotkeys for the drawing tools in Sprint-Layout. 
Select the desired drawing tool in the listbox and click on the arrow in Change hotkey to select a new key
for this mode.

Crosshair

 

Here you can make some additional settings concerning the look of the crosshair (reticule) in Sprint-Layout.
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AutoSave

This option you can increase the safety. You can define if, and in which time interval your project will be
saved automatically. This happens completely in the background, and you won't noticed it. The regularly
saved file will be saved in the same directory and with the same filename as the original file, only the
extension ".bak" is added to the file to differentiate it from the original file.

Created with the Standard Edition of HelpNDoc: Full featured multi-format Help generator

The Properties-Panel
 
The properties-panel offers the possibility to edit all important properties of your layout-elements without
calling special dialogs. 
To activate the properties-panel select Show Properties-Panel from the Options menu or click on the
corresponding button in the toolbar: 
 

 
The properties-panel appears on the right side of your layout.
If no element is selected, the properties of the board will be visible:

http://www.helpndoc.com/help-authoring-tool
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The properties-panel responds on the current selection on your layout.
If you select e.g. a single pad, you can edit its properties directly here:

 
In the same manner, you can edit all other elements like tracks, text labels, etc.
 

Multi-Selection
If you have select several elements or a group, you can edit the properties of all selected elements
simultaneously.
The multiselect-Box will appear at top of the properties-panel. Here you can select the element-type you
want to edit. Every change you will made now will affect all selected elements.
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Created with the Standard Edition of HelpNDoc: Full featured Documentation generator

Design-Rule-Check (DRC)
 
Because of little inaccuracies if a PCB will be produced, there are some tolerances and limitations to keep,
to get a usable Board. These values are named "Design Rules". Sprint-Layout is able to check some
important design rules, e.g. the minimum clearance distance between 2 copper tracks, etc. 

To check a layout with the DRC, activate the DRC-panel first.
Select Show DRC-Panel from the Options menu or click the corresponding button in the toolbar:
 

 
The DRC-panel will appear on the right.
 

http://www.helpndoc.com
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Here you can adjust the DRC-settings. You can also select or deselect single DRC-checks with the
checkboxes. 

Minimum distance copper:
The minimum clearance distance between copper tracks. 

Minimum distance drillings:
The minimum distance between 2 drilling holes. 

Drilling min: 
The minimal usable drill. 

Drilling max: 
The maximal usable drill. 

Track min: 
The minimal usable track width. 

Annular ring min: 
The minimal remaining copper-ring for pads (after drilling). 
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Silkscreen min: 
The minimal usable thickness for the silkscreen. 

Silkscreen over pads: 
This option checks, if parts of the silkscreen are on pads or on SMD-pads. 

Drilling on SMD-pads: 
This option checks, if drillings are on SMD-pads. 

Pads without soldermask: 
This option checks, if there are pads or SMD-pads on the board, which are not included in the soldermask
(caused by a manual editing of the soldermask). 

Soldermask out of pads: 
This option checks, if there are soldermask-areas on the board, which are out of pads or SMD-pads. This
can be made deliberate by a manual editing of the soldermask. 

Start DRC 
After you have made your settings you can start the DRC. 

Complete... 
This will start the DRC for the complete layout. 

Windows... 
This will start the DRC only for the part of the layout which is currently visible. 
This option is often useful, because the DRC needs some time. So if you have made only little changes on
your layout, you can zoom to this area and check only the visible area. 

The DRC result 
After the DRC, all detected errors are listed in the listbox below. Every entry shows the corresponding layer
and the detected error. All errors will be displayed on your layout with a white hatch.

Example with 3 errors (minimum distance)

If you want to display only single errors, just select them in the listbox. You can click on Select all to
select and display all errors. 

Tip:
If you double-click on an error in the listbox, your layout will automatic zoom to this error. So you can
navigate very fast to every listed error.
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The Selector

The Selector is a mighty tool. You can use it to search and select special elements on your layout. So it is
possible to search and select all pads with a special shape or size. If the desired elements are selected,
they can be changed in common with the properties-panel.

The Selector can also help to analyze your layout. So you can list e.g. all tracks sorted by their widths.
Such lists can help you to find unwanted elements.

You can call the Selector with the command Show Selector-Panel from the Options menu, or click on the
corresponding button in the toolbar:

The Selector appears on the right:

With the 3 combo-boxes at the top you can define the kind of sorting for the elements: 

Elements
Select the element-type you want to analyze.

Sorting
Select the kind of sorting, the Selector should use. The options in this box are depending from the selected
element-type.

Layer
Here you can filter the elements, depending on their layer.

The sorted elements will be listed in a tree-view, below this combo-boxes
If you select a group-entry in this list, all elements in this group will be selected on your layout.
If you expand a group, all elements of this group will be listed. Here you can also select a single element
instead of the whole group.

With the combination of the Selector and the properties-panel, you can now edit your layout selective.

http://www.helpndoc.com/help-authoring-tool
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E.g. you can select a group of pads in the Selector. All pads within this group will be selected on the layout,
and you can make your changes in the properties-panel for all pads in common.

Auto-Zoom
Each time you select an entry in the Selector, the elements will be selected on your layout, and Sprint-
Layout also zooms on this selected elements. You can change the zoom-level of this auto-zoom with the
trackbar. 

Blinking selections
The selected elements on your layout will be displayed in a blink-mode. This helps you to identify the
selected elements. You can disable the blink-mode in the General-Settings of Sprint-Layout.

Created with the Standard Edition of HelpNDoc: Easily create HTML Help documents

Automatic Capture-Mode

This function makes it much easier to connect tracks or place pads exactly. As soon as you move the
mouse-cursor near a capture-point, the mouse-cursor will be captured to this point and an exact connection
is guaranteed. This feature is very helpful, especially if some connection-points are not in the same grid.

Every time the crosshair is captured, it gets a red color:

http://www.helpndoc.com/feature-tour
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A captured crosshair

The automatic capture-mode can be enabled or disabled at any time.  Just click on the corresponding
button in the lower statusbar:

enabled disabled

Created with the Standard Edition of HelpNDoc: Easy CHM and documentation editor

Rubberband-Function

If you move elements, the tracks which are connected to pads can keep their connection like a rubberband.
The advantage is, that the connection won't break off, but normally you will have to edit this track after the
movement,

The rubberband.function can be set to one of the 3 levels by clicking the corresponding button in the lower
statusbar:

bis capture small capture off

The setting big capture means, that the recognition if a track is connected to a pad is working more
generous as in the setting small capture.
If small capture is set, the track has to be almost exactly on the pad center to recognize it as connected.
You can deactivate the rubberband-function by setting the level to off.

Created with the Standard Edition of HelpNDoc: Free help authoring environment

The Footprint-Wizard
 
The footprint-wizard may help you to create typical footprints of components.
You select a typical layout and set the parameters, and the wizard creates the footprint automatically. 

To start the footprint-wizard select Footprint-Wizard... from the Extras menu. 
 

http://www.helpndoc.com
http://www.helpndoc.com/help-authoring-tool
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There are 5 different layout types available: 

· Single row (SIP) 
· Dual row (DIP) 
· Square (QUAD) 
· Single circular 
· Dual circular 
·

Every layout type has some parameters. These parameters are displayed and explained in a little picture in
the footprint-wizard. 
Select the desired layout type from the listbox. The Default button sets the parameters to reasonable
values, so that you can see the meaning of the parameters. 

Pads 
Here you can select the type (normal or SMD) and the size of the pads. 

Number of Pads 
Her you can enter the number of pads 

Parameters 
Here you can adjust the parameters which are necessary for the selected layout type. 
Not every parameter is used from every layout type. 

The meaning of every parameter is displayed and explained in a little picture in the footprint-wizard. 
If you click OK the wizard will create your footprint, and you can place it on your layout.
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Edit the Solder mask
 
Normally, the solder mask will be created automatically by Sprint-Layout, and you don't have to care about
this.
Sprint-Layout is generating the solder mask by excluding all pads and SMD-pads from the mask, so that
these areas are solderable. 

Sometimes it is necessary to extend this solder mask, e.g. if you want to tin a track. 
In this case you can edit the solder mask. Click on the Solder mask button in the left sidebar to enter the
edit-mode for the solder mask:

 
All elements which are "solderable" will be displayed in white. Normally this are all pads and SMD-pads. 

In this mode you can now add additional elements to the solder mask, by clicking on it. This element will
added to the solder mask, and it will be displayed in white immediately.
 

 
Vice versa, you can also exclude an element from the solder mask. Just click on a white element to
exclude it. The element will displayed in his normal color immediately. 
You can reset the solder mask any time to the default setting (all pads and SMD-pads). To do this just
select Reset solder mask... from the Extras menu.
 
 

Created with the Standard Edition of HelpNDoc: Easy CHM and documentation editor

Gerber-Import

Sprint-Layout is able to read existing Gerber files, and tries to reconstruct a layout from the data.
The Gerber files have to be in the Extended-Gerber-Format (RS274-X). The obsoleted Gerber format with
additional aperture-file is not supported.

While the export to Gerber  is always an exact 1:1 reproduction of the layout, the reverse process is not so
obviously. This is because the Gerber file only represents an optical copy of a layout. A clear differentiation
between a track, a zone or a pad is not granted any more. Beside this, every application which can create a
Gerber file, can create this file in its own manner. There are many possible variations, but no concrete rules
to create a Gerber file. Anyway, Sprint-Layout will always try to interpret a Gerber file as well as possible to
get the best and optimal result.

To create a new board from Gerber files, select Gerber-Import... from the File menu.

http://www.helpndoc.com/feature-tour
http://www.helpndoc.com


82 / 86

Gerber (RS274-X)
Here you can select a Gerber file for each layer.

Select a new Gerber file with the "..." buttons. A file dialog will appear, and you can select the Gerber file.
Note, that already, if you select a file in the file-dialog, this file will be interpreted and the result will be
displayed in the preview of the main dialog. If the file-dialog overlaps the preview, just move the file-dialog
away, so that you can also see the preview. This feature is very useful, because Gerber files will often have
cryptic file names from which you can't recognize the content. If the file is not recognized as a valid Gerber
file, you can see a big X in the preview. If you nevertheless select such a file, the file name is displayed in a
gray color to mark this file as invalid.

Drill data (Excellon)
Here you can select a drill file. The drill file has to be in the Excellon file-format.
The drill file is important, because Sprint-Layout can only try to recognize pads automatically with the drill-
data.

Just like the Gerber files, you will see the preview of the drill file if you select the file in the file-dialog. The
drill file has some additional parameters concerning the numeric format which have to be set. Sprint-Layout
tries to recognize the correct numeric format of the drill file, but this automatic may not work for any file. You
can make the changes for the numeric format of the drill file in the dialog. If you don't know the used numeric
format of the drill file, you can just try several settings. The preview will always show the result of your
settings, and so you can see exactly if the settings are correct or not.

Create board
Here you can decide, if the new board should be created on a new tab, or if you want to create the new
board in the current selected tab.
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Create vias automatically
With this option, Sprint-Layout tries to recognize through-holes (vias) automatically. You may disable this
function if the result If this functions leads to undesirable results.

Optimize connected tracks
If activated, Sprint-Layout tries to recognize connected tracks and combines single track-segments to
complex tracks.

Import...
Click to Import... to create the new board.

Created with the Standard Edition of HelpNDoc: Free iPhone documentation generator

Project Info
 
Use this option to add copyright informations and comments to your project. 
You can open the project info with the corresponding button in the toolbar:
 

 
The project info will appear:
 

 
Here you can enter your project informations. In the comment-field, you can add annotations to your project
like pin-lists, background-information, clients, etc. 
The project info will be saved together with your project automatically.

Created with the Standard Edition of HelpNDoc: Easily create PDF Help documents

Keyboard Controls
 
You can control many functions of Sprint-Layout with the keyboard:

http://www.helpndoc.com/feature-tour/iphone-website-generation
http://www.helpndoc.com/feature-tour


84 / 86

 
CTRL-key
Hold down the CTRL key of your keyboard, to turn off the grid-capture, if you have to reach positions that are
off the grid. 
 
CURSOR keys
Use the CURSOR keys to move selected elements in steps of the current grid. If you press also the CTRL
key, you can move the selected elements in steps of 0,1 mm.
 
SPACE key
While drawing a track or a zone, you can change the bend mode of the track by pressing the <SPACE>
key. There are 5 bend-modes altogether and you can simply toggle through these modes with the
<SPACE> key.
 
DEL key
Deletes the selected elements from your layout.

ALT key
If you want to select a single element out of a group or a macro, just press and hold the ALT key and then
click on the desired element.

SHIFT key
If you want to select several single elements, press and hold the SHIFT key and now you can select one
element after another without deselecting the former selected elements.

Hotkeys for the mode-buttons
 
ESC Standard
Z Zoom
T Track
P Pad
S SMD-Pad
R Circle
Q Rectangle
F Zone
N Special form
L Text
C Connection
A Autoroute
X Test
M Measure
V Photo-View
O Solder mask
 
You can define these hotkeys in the  General Settings.
 

1..9 keys
With the keys 1..9 you can select predefined grid values.

Miscellaneous hotkeys
 
CRTL-Z
Undo
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CTRL-Y
Redo
 
CTRL-C
Copy
 
CTRL-X
Cut
 
CTRL-V
Paste
 
CTRL-D
Duplicate
 
CTRL-A
Select all
 
CTRL-R
Rotate
 
CTRL-H
Mirror horizontal
 
CTRL-T
Mirror vertical
 
CTRL-G
Build group
 
CTRL-U
Split group
 
CTRL-W
Change board side
 

Created with the Standard Edition of HelpNDoc: Easily create Web Help sites

The Viewer
 
The Sprint-Layout-Viewer is an independent and free application, which is uses to open, view and print
layout files.
The viewer is freeware, and you are allowed to copy and publish this viewer, so everyone can view and print
your layout files, even if they don't own the original Sprint-Layout application.
 
The viewer is located in just 1 file: Sprint-Layout60_Viewer.EXE

The viewer can be downloaded from our homepage.

Created with the Standard Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

Tips and Tricks
 

· Hold down the CTRL key of your keyboard, to turn off the grid-capture, if you have to reach positions
that are off the grid. 

· If you want to select a single element out of a group or a macro, just press and hold the ALT key and
then click on the desired element.

http://www.helpndoc.com/feature-tour
http://www.abacom-online.de/uk
http://www.helpndoc.com/help-authoring-tool
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· If you want to select several single elements, press and hold the SHIFT key and now you can select
one element after another without deselecting the former selected elements.

· Use the CURSOR keys to move selected elements in steps of the current grid. If you press also the 
CTRL key, you can move the selected elements in steps of 0,1 mm.

· While drawing a track or a zone, you can change the bend mode of the track by pressing the SPACE
key. There are 5 bend-modes altogether and you can simply toggle through these modes with the 
SPACE key.

· With the keys 1..9 you can select predefined grid values.

· If you want to connect an element (e.g. a pad or a track) with the automatic ground-plane, just select
this element and set the distance in the lower statusbar to the ground-plane to "0" (zero).

· The polygons you can create with the Special-Form function, can be used excellent as a construction-
help. For example, if you need a component with 12 pins arranged in a circle, you can create a 12-
sided-polygon, place a pad on every edge and delete the polygon. 

· You can change the width of the macro-library. Move the mouse to the boarder line between the library
and the editor. The mouse cursor changes to a double arrow. This indicates that you can move the
border, while you hold down the left mouse button.

· If you want to publish your layouts in the web, you can export your layout to a JPG or GIF file. You may
also offer your original *.lay file as a download, and refer to the free Viewer.

· You can always search for a new update with the command Internet Update... from the ? menu.

Created with the Standard Edition of HelpNDoc: Easily create HTML Help documents
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